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Introduction to StayAlive

StayAlive is the premier crash protection software for Windows.

The goal of StayAlive is to keep your applications running when they crash, thus allowing you to save your work and 
exit the application gracefully.    In fulfilling this goal we hope that StayAlive makes you more productive and removes 
the frustration of losing hours of work when an application crashes.

We set ourselves some steep objectives in developing StayAlive because we wanted to make your life as a software 
user simpler.    We certainly didn’t want you to pay a high price for increased software reliability, since you, as a 
customer, should have been able to expect that in the first instance.

The result is:

· StayAlive should never make matters worse.

· StayAlive works in the majority of application crash scenarios.

· StayAlive has a small memory requirement.

· StayAlive has a negligible (approaching zero) speed impact on your system.



Disclaimer

By its very nature, StayAlive is very much out on the edge trying to deal with complex scenarios inside software which
was developed using various techniques that we may not even be able to guess at.

Whilst we’ve worked hard to bring you a great product which will always save the day (and your work!) we cannot 
guarantee to save your applications in 100% of cases.    In some scenarios StayAlive may have no effect at all, in 
others you may find that it is always there to help you out.

We therefore make no warranty, implied or otherwise, about the functionality of StayAlive.    All conditions described in
the license provided with this software apply and by installing the software you agree to the conditions therein.

Microsoft, Windows, Windows NT, Windows 95 and Windows 98 are registered trademarks of Microsoft Corporation, 
Redmond, Seattle.

All other trademarks are recognised.



Installing StayAlive

StayAlive is available for Windows 95, Windows 98 and Windows NT 4.0.

To install StayAlive from the internet:

· Using your internet browser, select SA21.EXE from http://www.tfi-technology.com/downloads.htm.    When 
prompted you should choose to Open the file.    

· The file SA21.EXE will now be downloaded.    When the download has completed, the setup utility will guide 
you through the rest of the installation.

To install StayAlive from the supplied floppy disk:

· Insert the floppy disk into the drive.

· From the Windows Start Menu select Run.    In the dialog that appears enter A:\setup, then press the Return 
key.

· The setup program will now lead you through the rest of the installation.

· Once the installation has completed you should remove the floppy disk from the drive and store it in a safe 
place.



Unlocking (Registering) StayAlive

After you have bought a license you may unlock your copy of StayAlive using the Unlock button.    This button can be 
found on the StayAlive About Box.

The Unlock dialog requires you to enter your name and your license key.    The name and key that you enter should 
be exactly the same as those that were specified when you obtained your license key.

If you have not yet bought a license key you may obtain one immediately over the World Wide Web by pressing Buy 
Now on the Help Menu or on the StayAlive About Box.

Note

A trial version of StayAlive is available for initial evaluation.    This allows an opportunity for customers to become 
familiar with the application and evaluate its usefulness before purchasing.



Uninstalling StayAlive

StayAlive is provided with an automatic uninstall utility.

To uninstall StayAlive you should choose Add/Remove Programs from the Control Panel (Control Panel can be 
invoked using the Settings option from the Start Menu).    Choose StayAlive on the list of applications and then click 
the ‘Add/Remove’ button.    StayAlive will now be automatically removed.



The Tray Icon

By default, StayAlive displays an icon in your system tray when it is running in the background (the system tray is on 
the right of your Start Menu task bar).    Besides being an indication that StayAlive is running this icon can be used in 
the following ways:

· To quickly determine if an application is not responding

When you hover your mouse pointer over the icon a message will appear above the icon that indicates if StayAlive 
believes any applications have stopped responding.

· To open the StayAlive Screen box

You can open the StayAlive Screen either by double clicking on the icon, or by right clicking on the icon and selecting 
Open from the menu.

· To shutdown StayAlive

To stop StayAlive from running you can right click on the icon and select ‘Shutdown StayAlive’ from the menu.    This 
will cause StayAlive to stop running in the background.

· To shutdown Windows

Select the 'Shutdown Windows' option to shutdown and restart Windows.    Whilst this is similar to the Shutdown 
option on the Windows Start button menu, StayAlive offers an improved shutdown feature that will force applications 
to shutdown for you.



The StayAlive Screen

The StayAlive Screen can be displayed by selecting StayAlive from the Start Menu or by using the Tray Icon.

The StayAlive Screen consists of the following tabs:

The Applications Tab

The Processes Tab

The Options Tab

This screen also provides the following menus:

The File Menu

The Help Menu



The Applications Tab

This tab provides a list of the applications that are currently running with an indication of their individual status.    In 
most cases the status of an application will be reported as ‘Running’.    However, if the application has been 
determined to have ‘hung’, the status will be reported as ‘Not responding’.

· Recovering an Application

There are two ways to recover an application that appears in the application list:

· Select the application you want to recover and then press the Recover button.

· Double-click on the application in the list.

If the application does not appear to be having any problems you will be prompted to confirm this action before 
StayAlive is begins the recovery process

Note: The recovery process available from this screen is only applicable to applications that have stopped 
responding.    StayAlive will automatically recover applications that are suffering from some other kind of error.

· Killing an Application

Often an application will stop responding and your only option is to stop running (i.e. ‘Kill’) the application.    You can 
kill an application by selecting the application from the list and then pressing the Kill button.    StayAlive will then lead 
you through the kill process.

· Running a new Application

To run a new application you can either press the Run button, or choose Run Application from the File Menu.    This 
will cause the Run dialog to be displayed.



The Processes Tab

The Processes tab provides a list of all of the processes that are running.    This is similar to the Applications list, with 
the main difference being that not all of the processes that are running on your system will be applications.

Like the application list, you may use the process list to make StayAlive recover a process.    You can do this by 
double clicking on an item in the list or by selecting an item and pressing the Recover button.    

You can also use the Kill and Run buttons in the same way as for the application tab.

Note:    Exercise some caution when recovering a process, since processes that are not reported as applications may 
not be available for recovery with StayAlive.    This is because StayAlive's crash protection scheme was designed 
specifically for applications.



The Options Tab
The Options tab allows you to configure the behaviour of StayAlive.    The options you change here have an 
immediate effect, so you can quickly and easily customise StayAlive to suit your needs.

General Options

These options configure the behaviour of StayAlive.

· Run in the background

When this option is enabled the StayAlive crash protector will be able to intercept crashes in your applications earlier. 
This option therefore reduces the chances of lost work and increases the chances of a good recovery.

Note: StayAlive is more effective with this option enabled.    You can stop running StayAlive in the background at any 
time without changing this option by selecting ‘Shutdown StayAlive’ from the File menu.

· Show Tray Icon

When this option is enabled StayAlive displays an icon in your task bar.    This icon allows you to quickly open the 
StayAlive Screen or to quickly determine if any applications do not appear to be responding.

· Installed as Windows Crash Handler

With this option enabled StayAlive will be able to catch errors even when it is not running.    This is similar to the way 
utilities such as Dr Watson work.    If you would prefer to use Dr Watson then disable this option.    Note: StayAlive is 
more effective with this option enabled.

· Show Free Memory on Status Bar

When this option is enabled the amount of unused memory will be displayed on the status bar.    The amount 
displayed is total memory: the sum of physical RAM (e.g. 16 Mb) and page file memory (e.g. 72 Mb); it is therefore 
the total amount of unused virtual memory.

Launch Options

These options control how StayAlive can be launched.

· Use StayAlive Hot-key

This option enables or disables the StayAlive hot-key.    When this option is enabled, StayAlive can be displayed at 
any time by pressing a defined key-combination.    The default key combination is CTRL+ALT+O (i.e. press the 
Control, Alt and ‘O’ keys simultaneously).    You can change this by entering another combination in the box provided. 
The hot-key option is useful when you are having difficulties displaying the StayAlive screen e.g. when your system is
not responding.    Note: this option is only available when StayAlive is running in the background.

· Run at Windows start-up

When this option is enabled StayAlive will automatically run when Windows starts.

Crash Options

These options apply when StayAlive intercepts a crash.

· Play a sound

When this option is enabled StayAlive will play a sound when it intercepts a crash.    You can change the sound that is
played by pressing the Browse button and selecting a different sound file from you file system.    If you would prefer 
not to play a sound when a crash is intercepted you can disable this option.



The File Menu

The File Menu provides the following options:

· Run Application

This menu option allows you to run a new application.    After selecting this option the Run dialog will be displayed.

· Shutdown StayAlive

This menu option allows you to stop running StayAlive.    This will also cause StayAlive to stop running in the 
background.

· Shutdown Windows

Select the 'Shutdown Windows' option to shutdown and restart Windows.    Whilst this is similar to the Shutdown 
option on the Windows Start button menu, StayAlive offers an improved shutdown feature that will force applications 
to shutdown for you.

· Exit

This menu option will exit the StayAlive screen but continue to run StayAlive in the background when the Run in the 
background option is enabled.



The Help Menu

The Help Menu provides the following options:

· Contents

Choosing this menu option causes the main help contents screen to be displayed.    You can then select the topic that
you need help with.

· Buy Now

Takes you the purchase page on the TFI Technology web site.    From this page you can obtain a key to unlock 
StayAlive.

· Unlock

Having bought a key, you can use this option to enter your key and unlock StayAlive.

· About StayAlive

Choosing this menu option will display the StayAlive About Box.



The Run Dialog
The Run dialog allows you to run a new application and immediately have StayAlive attach itself to it. This tab is 
useful if an application appears to crash immediately after it has been run.    Since StayAlive is automatically applied 
to the application, the crash will immediately be caught.

You may run an application either by typing the full path and filename of the application in the Open edit box, or by 
pressing the Browse button and selecting a file from the explorer dialog.    In either case, when a valid filename is 
entered you may press the Run button to cause the application to be run.



The StayAlive About Box

The StayAlive About Box displays the version number of StayAlive and copyright notices.

Using the About Box you can register/unlock your copy of StayAlive by pressing the Unlock button.



Drag 'n' Crash

Drag 'n' Crash is a program that can be used to crash your Windows programs.    In this way you can put StayAlive 
through its paces.

To run Drag 'n' Crash, simply select it from the StayAlive menu on your Start Menu.

You use Drag 'n' Crash by dragging the crash tool (denoted with a skull and crossbones) over the program that you 
would like to crash.    The process is as follows:

· Position the mouse cursor over the skull and crossbones.

· Press down with the left mouse button.

· With the left mouse down still held down, move the mouse (this is dragging) over the program you would like to 
crash.    As you move the mouse over the programs, the program will be highlighted with a red glow.

· Having selected the program you want to crash, release the left mouse button.

· The program will immediately crash.

When StayAlive is installed the crash will be intercepted and you will be able to recover the application.

To find out what would happen without StayAlive installed try disabling the 'Enable StayAlive' option then crashing a 
program using the crash tool.    Then re-enable StayAlive and try crashing the program again.

Notes:

· You should always save your work before crashing applications.

· You cannot use this tool to crash StayAlive, Drag 'n' Crash, or 16-bit programs.



Crash Tour

For the vast majority of the time that StayAlive is running you will be unaware of its presence.    However, you will be 
very glad it is there when an application crashes, since it represents your best chance of saving your work.

In the course of keeping your applications alive, StayAlive will prompt you to take actions based on the state of the 
application.    In most cases you will probably just choose the default response to the message.

However, in cases where you aren’t sure which action to take, the following help topics will be of interest:

What is a Crash?

After a Crash

Persistent Crashes

Not Responding Applications

Killing an Application

Application Shutdown

Fatal Errors



What is a Crash?

What do we mean when we talk about an application ‘crashing’?    Depending on who you ask you will get different 
answers to this question.    By crash we mean one of two general scenarios:

· An unhandled exception occurs.    This is either caused by an application not handling ‘exceptional’ conditions, 
such as lack of memory or lack of disk space, or by an error in the application which leads to (for example) 
memory access errors.    In the days of Windows 3.1 this was commonly known as a General Protection Fault or 
GPF.

Without StayAlive, the operating system would normally display a message reporting the error and the 
application would be shutdown.    Your work would be lost.

· The application stops responding, or has ‘hung’.    There are a number of reasons for this, including a logic error 
causing the application to enter an infinite loop, the application waiting for a response from some other system 
(e.g. a server) or because the application is deadlocked waiting for a resource which can never be released.

Without StayAlive, you would be faced with a dilemma.    You may either continue to wait for the application to 
respond, or you can ‘kill’ the application by using Task Manager under Windows NT or the Task List under 
Windows 95/98.    If the application doesn’t respond or you have to kill the task, your work will be lost.

With StayAlive there is still a distinction between these types of crash, though the result should be the same: the 
application will remain responsive long enough for you to save your work.



After a Crash

When a crash occurs, StayAlive will intervene by displaying the Error Caught message.

This message tells you the name of the application that caused the crash and the error that has occurred.

In response to this message you can take one of the following actions.

· Recover

This is the default option and the one that we recommend you to use if you want StayAlive to try and recover your 
application and allow you to save your work.    After pressing Recover, StayAlive will attempt to recover the application
– if this is successful you should be able to return to the application and save your work.

As stated in the dialog, we strongly recommend that you save your work immediately and exit the recovered 
application.    This is because the application is obviously having problems and although it may appear to be behaving
normally after StayAlive has saved it, the problems are likely to still be present.

In addition we recommend that you save your work to another file if possible.    This will ensure that if the application 
saves a corrupted version of the file as a result of the errors it is experiencing you will not lose the previously saved 
version of the file.

· Quit

The Quit option allows you to terminate the application immediately, thus bypassing StayAlive and the normal 
operating system behaviour.    This option should only be used if you know that you do not want to keep the 
application alive so you can    save your work (and that the default Windows behaviour is undesirable).

· Ignore

By pressing Ignore you are instructing StayAlive to ignore the error and to Windows to continue and perform its 
default action.    The default action taken by Windows will depend on your configuration, but it usually consists of a 
fatal error message being displayed followed by the application being shutdown.    In other cases the operating 
system may launch a system debugger.

Most users should not use this option since the default action taken by the operating system is unlikely to give you 
the opportunity to save your work.    Application developers should use this option if they have a system level 
debugger installed and would like the opportunity to debug the crashed application rather than to keep it alive.



Persistent Crashes

Having kept the application alive after a crash, the application may continue to cause errors.    StayAlive will silently 
handle most of these errors, but if there are too many it is likely that the application is in severe difficulty.    In this case
StayAlive will display the Continue Running message.

This message displays the name of the application which is having difficulty and the last known error that the 
application caused.

In response to this message you may take one of the following actions.

· Continue

If you select Continue, StayAlive will try to keep the application alive.    On returning to the application you should 
save your work and exit the application immediately.

Having kept the application alive you may be presented with this message again because the application is still 
persistently causing errors.    In this case you may have to quit the application.

· Quit

To stop trying to keep the application alive you can select the Quit option.    This will cause the application to end 
immediately.



‘Not Responding’ Applications
StayAlive offers you the ability to manually recover an application that you think is not responding.    To do this you 
should use the Recover button on the Application Tab of the StayAlive Screen.

Once StayAlive has recovered the application (either by using the StayAlive Screen or because the application was 
automatically saved by StayAlive as a result of a crash), StayAlive will track the responsiveness of the application.    If
the application does not appear to be responding, the Not Responding message will be displayed.

This message displays the name of the application that does not appear to be responding.    In response to this 
message you may take the following actions.

· Interrupt

The Interrupt option will cause StayAlive to interrupt the application and attempt to make it responsive again.    As in 
the case of an exception, once StayAlive has made the application responsive you should save your work 
immediately using a different filename, and exit the application.

If StayAlive is unsuccessful in interrupting the application, this message will be displayed again after a short time 
period.    If you select the Interrupt option again, StayAlive will attempt to interrupt the application again.    However, 
you may have to give up on this course of action and cause StayAlive to terminate the application by choosing the 
Quit option.

· Ignore

The Ignore option allows you to continue waiting for the application.    When this application is chosen, StayAlive will 
not intervene, though the above message will be shown again after a short time if the application still does not appear
to be responding.

· Quit

To cause the application to shutdown immediately you should choose the Quit option.    This option should only be 
used as a last resort if the application does not appear to be responding, even after StayAlive has attempted to 
interrupt the application.



Killing an Application

It is sometimes the case that an application cannot be interrupted and that you are unable to close it down.    In this 
scenario you have no option other than to shut down the application by hand.    StayAlive allows this you to do this 
using the Kill option.

To kill an application, you should select the application from the Application List in the StayAlive Screen, and press 
the Kill button.    This will begin the kill process.

The first attempt that StayAlive makes when killing an application is quite soft.    It simply asks the application to shut 
itself down.    This is the preferred option since the application should then save any necessary data and prompt you 
to save your work.

If an initial attempt to kill an application fails, StayAlive will display the Kill Failed message.    This message provides 
you with two options:

· Retry

The Retry button will cause StayAlive to try and kill the application again by asking it to shutdown.    After pressing this
button the application will either shutdown, or after a short time this dialog will be displayed again.

· Force

The Force button will cause StayAlive to continue the kill process.    StayAlive will try to physically cause the 
application shutdown.

This option should be used with some care, since the application will not be given the opportunity to save any data.    
In rare cases you may experience difficulties the next time you run the application, and in any case you will lose any 
current work.

· Stop

This causes StayAlive to stop trying to kill the application.

Having chosen the ‘Force’ option most applications will shutdown.    However, if StayAlive is still unable to kill the 
application the Kill Aborted message will be displayed.    In this case you may either try to kill the application again by 
selecting it and pressing the Kill button, or you will have to restart Windows to kill the application.

Note: You can also kill an application using the Task Manager under Windows NT or the Task List under Windows 
95/98.    The only real difference between these methods and the StayAlive Kill option are that StayAlive may often be
more effective in killing the application.



Application Shutdown

In some cases StayAlive may be over zealous in keeping your application alive.    In other cases the error that caused
StayAlive to be invoked may prevent the application from shutting down properly.

In either of these cases StayAlive will detect that the application should have shutdown and the Terminate Application
message will be displayed.

This message displays the name of the application that appears to have terminated and allows you to take the 
following options.

· Quit

This is the default option.    It allows you to stop keeping the application alive and terminate it immediately.

· Continue

This option allows you to keep the application alive.    After you choose this option the application will remain alive 
until either it exits or you kill it.



Fatal Errors

In some extreme cases an application will cause an error that StayAlive cannot handle.    In this case StayAlive will 
display the Fatal Exit message and the application will be terminated.

This is a rare event, so you should never see this message.



Questions & Answers

Q. Why is StayAlive better than other crash protection schemes?

A. The main advantage that StayAlive brings is a unique 'inside-out' protection technology. For a large percentage of 
the time that a Windows application is running it is inside operating system code.    By placing itself at the boundary 
between the application and the Windows operating system, StayAlive is more effective and more likely to catch 
errors than other crash protection software.

StayAlive offers many other advantages, not least of which is its small memory requirement and its insistence on 
using less than 1 Mb of your hard disk space.    We can do this because we're giving you what you really need to 
avoid losing work.

Q. What does ‘Run in the Background’ mean?

A. When StayAlive is running in the background it is able to transparently attach itself to your applications.    When 
StayAlive is attached in this way it is able to catch errors early and handle them more effectively.

Whilst it is running in the background, StayAlive will consume a small amount of computer time and memory.    This 
overhead is small and we believe is worth the cost since it provides better protection.

Q. I have stopped running StayAlive in the background, but it is still catching errors.    Why?

A. StayAlive is most effective when it is running in the background, but that is not the only type of protection that it 
offers.    The Windows operating system offers a Just-in-Time debugging feature that StayAlive uses to catch errors.

To prevent StayAlive from behaving in this way you should uninstall StayAlive.

Q. An application has stopped responding but StayAlive reports it as responding.    Why?

A. An application may stop responding for a number of reasons, not all of which will be detected by StayAlive.    The 
application may not have stopped responding completely, but may be performing a lengthy calculation or accessing a
network resource over a slow network.

You can still interrupt the application, even when it is reported as ‘responding’.

Q. Will StayAlive be able to keep every application alive?

A. The simple answer is ‘no’.    Some software errors leave the application so unstable that recovery is impossible.    
In other cases errors may be caused by hardware faults.    We have tested StayAlive in many different crash 
scenarios and the results indicate that StayAlive will work in the vast majority of cases.

Q. Does StayAlive work with 16-bit applications?

A. No, StayAlive does not work with old 16-bit applications.

Q. Why is the OK button disabled in the unlock dialog?

A. The OK button will be enabled when a valid user name and license key combination are entered.    The name must
be exactly as it was entered when you obtained your StayAlive license.

Q. How do I recover an application that has stopped responding?

A. Display the StayAlive screen by either by double clicking the icon in the system tray or by running it from the Start 
menu.    When the screen appears you should select the Application Tab.    Using this tab you can select the 
application is not responding and then press the Recover button .

Q. I am a software developer.    Will StayAlive interfere with my system level debugger?

A. Under Windows NT and Windows 98 StayAlive will have no effect during a debug session.    Under Windows 95, or
when you are running outside of a debug environment and would rather launch the debugger than save the 
application, you should press the ignore button when the Error Caught message is displayed.

Q. How do I contact TFI Technology?

A. You can contact TFI Technology in the following ways:

E-Mail: enquiry@tfi-technology.com

Internet: http://www.tfi-technology.com

Postal Address: 



TFI Technology Ltd
PO Box 160
West Drayton
UB7 8PY
United Kingdom



Contacting TFI Technology

You may contact TFI Technology in the following ways:

E-mail: enquiry@tfi-technology.com

Internet: http://www.tfi-technology.com

Post: TFI Technology Ltd
PO Box 160
West Drayton
Middlesex
UB7 8PY

TFI Technology Ltd is registered in the UK and Ireland.
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The Recover Button

Causes StayAlive to recover the selected application.    This should be used when an application is reported as ‘not 
responding’.



The Crash Tool

Drag the tool over a program you would like to crash and then release the mouse button.    The selected program will 
then crash.



The Recover Button

Causes StayAlive to recover the selected process.    



The Application List

The application list displays all of the currently running applications on your computer.

The status of the application is displayed to the right of the application name.    

The status can be:

‘Running’, this means that the application appears to be working correctly

‘Not Responding’, this means that the application has ‘hung’

To recover an application that is not responding you should either double-click on the application in the list, or select 
the application and press the Recover button.



The Browse for File Button

This button allows you to browse your file system for a program to run.

This is easier than entering the full path of the file in Open box.



The Open Box

Enter the path and filename of an application here and then press Run.    

StayAlive will then run the application and immediately interrupt it.    This is useful when an application is crashing 
immediately after you have run it.



The Process List

The process list displays all of the currently running processes on your computer and their process ID’s.

To use StayAlive to recover a process you can either double-click on a process in the list, or select a process then 
press the Recover button.



The Run Button

This causes StayAlive to run the application that you have entered in the Open box.    StayAlive will be interrupt the 
application immediately after it has started running.    This is useful for applications that crash immediately after they 
have run.



The OK Button

Press the OK button to end the dialog.



The Cancel Button

Press the Cancel button to end the dialog.



The Continue Button

Press the Continue button to continue running StayAlive and the application that StayAlive is keeping alive. 



The Ignore Button

Press the Ignore button to ignore the StayAlive message.    StayAlive will not take any further action based on the 
event being reported and the application will continue with whatever task it is performing.



The Interrupt Button

Press the Interrupt button to cause StayAlive to interrupt the task that the application is currently performing.    If the 
application is not responding (i.e. ‘hung’) then it should start responding after it has been interrupted.



The Quit Button

The Quit button causes StayAlive to stop keeping the application alive.    Note that this option will cause the 
application to terminate.



The Buy Now Button

Press this button to buy StayAlive.    When you press Buy Now your default internet web browser will open the 
StayAlive purchase page.



The Unlock Button

Press this button to unlock (register) StayAlive.



The Help Button

This button allows you to view the main StayAlive help file.



The Recover Button

The Recover button allows you to try and keep the application alive.    After pressing Recover, StayAlive will attempt 
to recover the application – if this is successful you should be able to return to the application and save your work.

After recovering the application you should save your work immediately (preferably with a different filename) and exit 
the recovered application.



About StayAlive

This menu option allows you to display the StayAlive version and copyright notice.



The Applications Tab

The Applications Tab displays a list of the currently running applications and the status of those applications.

You can use this tab to manually apply StayAlive to an application.    This is most useful when an application appears 
to have stopped responding, since StayAlive will allow you to interrupt the application after it has been applied.



The Process Tab

The Processes Tab displays a list of the currently running process.

You can use this tab to manually apply StayAlive to a process. 



The Run Dialog

This tab allows you to browse for an application file that StayAlive will run and then immediately interrupt.

This is most useful when an application appears to be crashing immediately after it has started.



The Error Caught Message

This message is displayed when StayAlive intercepts a fatal error in an the application.

Using this screen you can either recover the application so that you can save your work, ignore the error and allow 
Windows to handle the error, or you can quit the application immediately.



The Continue Running Message

This message is displayed when an application is repeatedly causing fatal errors. 

Whilst StayAlive can continue trying to keep the application alive, it is likely that the application is beyond recovery 
and should be shutdown.



The Not Responding Message

This message has been displayed because the application that StayAlive is attached to does not appear to be 
responding.

Using this dialog StayAlive can interrupt the application and make it responsive again, you can ignore the message 
and allow the application to continue so you can try and save your work, or you can quit both StayAlive and the 
application.



The Terminate Application Message

This message has been displayed because an application that StayAlive was keeping alive appears to have 
terminated.

Using this dialog you can allow StayAlive to close the application, or you can allow the application to continue 
running.



The Run in the Background Option

This option allows StayAlive to run in the background.    With this option enabled StayAlive is more effective at 
catching errors.

Recommended value: Enabled



The Show Tray Icon Option

This option displays/hides the StayAlive tray icon that in displayed in the system tray (to the right of the task bar). 



Installed as Windows crash handler

Windows has what is known as a Just-in-Time debug feature.    When a program crashes, Windows will run the 
program that is installed as the debugger (or crash handler if you prefer).    In this way StayAlive can intervene when a
program crashes, even though StayAlive isn't actually running.    Disable this option if you don't want StayAlive to 
provide this type of protection.

Recommended value: Enabled



Show Splash Screen

Controls the display of the StayAlive splash screen when StayAlive is first started. If its turned off no splash screen 
will be displayed.



The Use Hot-Key Option

This option allows you to specify a short-cut key (known as a hot-key) that will be used to display StayAlive.    This is 
useful when you are having problems with your system that make it difficult for you to activate StayAlive.    This option
is only available when StayAlive is running in the background.

Recommended value: Enabled



The Show Free-memory Option

When this option is enabled StayAlive displays the amount of free memory on your machine on the status bar that is 
displayed at the bottom of the StayAlive screen.

Note: the free memory display is the total amount of memory in megabytes.    This is calculated as the total amount of
free RAM (e.g. 16 Mb) + the total amount of free paging file space (e.g. 72 Mb).



The Browse for Sound Button

StayAlive will play a sound when a crash occurs and the 'Play a sound' option is enabled.    You should press this 
button to browse your file system for the sound file that will be played.



The Crash Sound

This is the sound that will be played when StayAlive intercepts a crash and the 'Play a sound' option is enabled.



The Play Sound Option

Enable this option to have StayAlive play a sound when it intercepts a crash.



The Send Mail Button

Press this button to e-mail details of the application that has crashed to a technical support member or other 
interested party (e.g. the software vendor).



The Save Button

Press this button to save the crash details to a specific log file on your PC.    This log file can then be viewed by a 
technical support member or other interested party (e.g. the software vendor).



The Details Button

Press this button to view more details about the crash.



The Details Box

This displays details about the crash.    A technical support worker or software developer may be able to use this 
information to determine what went wrong.    Press the Mail button to e-mail these details, press Save to store them in
a file or select the text in the box and right-click to use clipboard options.



The Hot-Key Box

This box is available when the Use Hot-key Option is enabled.    It allows you to specify which key combination to use 
in order to display StayAlive.    Ctrl+Alt+O is the default hot-key, meaning that you must press the Control, Alt and O 
keys simultaneously to display StayAlive.



The Run at Start-up Option

When this option is enabled, StayAlive will automatically start running when your Windows session starts.    Note that 
if you have the Run in the Background option disabled, StayAlive will not run.

Recommended value: Enabled



The Kill Button

This button allows you to terminate the selected application.



The Kill Button

This button allows you to terminate the selected process.



The Run Button

This button allows you to run a new application.



The Run Button

This button allows you to start a new process.



Run Application

This menu option allows you to run a new application.



Shutdown StayAlive

This menu option allows you to exit StayAlive and stop it running in the background.



Exit

This menu option allows you to exit the StayAlive screen but continue running StayAlive in the background (if this 
option Is enabled).



Run in the Background

This menu option allows you to stop StayAlive running in the background.



Help Contents

This menu option allows you to display and select from the StayAlive help contents.



Kill Confirm

Killing an application may be dangerous since it is a final step and cannot be reversed.    Press the Yes button only if 
you are sure you want StayAlive to kill the application.



Query Application Recovery

The application you have chosen does not appear to be having any problems.

NB: Interrupting an application that is not experiencing problems may cause the application to behave unexpectedly.

You should press the Yes button only if you are sure that the application requires recovery.



Query Application Recovery

The process you have chosen does not appear to be having any problems.

Interrupting a process that is not experiencing problems may cause the process to behave unexpectedly.

You should press the Yes button only if you are sure that the process requires recovery.



Shutdown StayAlive

StayAlive is more effective when it is running in the background.    You should press the Yes button only if you are 
sure that you do not want StayAlive to continue running in the background.

You can start StayAlive again by selecting StayAlive from the Start Menu.    You may prefer to just close the StayAlive 
screen by choosing the Exit option instead.



The Force Kill Button

Press this button to make StayAlive force the application to shutdown.

Note that forcing an application to shutdown may occasionally make subsequent use of that application unstable.



The Stop Kill Button

Press this button to stop the attempt to kill the application.



The Retry Kill Button

Press this button to try and kill the application again.



Application Name

This is the name of the application that this message refers to e.g. Microsoft Word.



Application Location

This is the full path and filename of the application that this message refers to e.g. C:\Program Files\Microsoft Office\
Microsoft Word.exe.



Error Description

This is a brief description of the error that was caught.    You can save or e-mail these details using the buttons 
provided.



Buy Now

This menu option allows you to buy StayAlive online.



Unlock

This menu option displays a dialog that lets you enter the coded key you obtained when you bought StayAlive in 
order to unlock the 30-day evaluation security.



Crash Corner

This menu option will take you the Crash Corner page on the internet.    This is a source of crash scenarios in today's 
popular software packages.



StayAlive Home Page

This menu option will take you to the StayAlive home page on the internet.    This page provides breaking news and 
updates about StayAlive.



TFI Technology Home Page

This menu option will take you to the TFI home page on the internet.    This page provides news on TFI products, 
including StayAlive.



TFI Technology Home Page

Click here to visit TFI on the World Wide Web.



Shutdown Windows

Select the 'Shutdown Windows' option to shutdown and restart Windows.    Whilst this is similar to the Shutdown 
option on the Windows Start button menu, StayAlive offers an improved shutdown feature that will force applications 
to shutdown for you.



The Shutdown Option

When this option is enabled, Windows will shutdown to a point where you can power-off or reset your computer.



The Restart Options

When this option is enabled, Windows will shutdown and automatically restart.



Force applications to terminate

When this option is enabled, applications will be forced to close during the Windows shutdown process.



The Yes Button

Press this button to answer Yes to the question.



The No Button

Press this button to answer No to the question.



The StayAlive Enabled Option

When this option is enabled, StayAlive will be enabled.    By enabling and disabling this option you can enable and 
disable StayAlive. To use this option effectively, try disabling the option and causing a crash.    Then try re-enabling 
the option and causing a crash.




